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Respiration 
 
Background 
The amount of air that moves in or out of the lungs during any 
one breathing cycle is called the tidal volume. Above and 
beyond normal inspiration, it is possible to breathe in additional 
air—this is called the inspiratory reserve volume. Similarly, 
after a normal expiration, it is possible to exhale additional air 
from the lungs—this is the expiratory reserve volume. Even if 
the expiratory reserve volume is fully expelled from the lungs, 
there is still a volume of air in the lungs, called the residual 
volume, which cannot be exhaled. The residual volume has 
low oxygen and high carbon dioxide concentrations. Upon 
inhalation, fresh air mixes with stale air from the residual 
volume to create air in the alveoli that still has gas 
concentrations that facilitate the diffusion of oxygen into and 
carbon dioxide out of the capillaries.  
     The respiration center in the medulla insures that gaseous 
exchange at the lung matches the requirements of the body. 
During times of increased demand, the tidal volume can be 
increased, using some of the reserve lung volumes to bring 
more fresh air into the body. In addition, the rate of breathing 
can be changed. The respiratory rate and the tidal volume are 
multiplied to calculate the ventilation rate (usually in L/min.)   
 
Equipment Required 
PC Computer 
iWorx unit, and USB or serial cable 
SP-304 Spirometer 
FH-300 Spirometer flow head and plastic tubes 
Needle and thread 
 
 

 
Figure 1: Connect the spirometer to the iWorx/214 unit. 

 
Equipment Setup 
1 Firmly push the two air flow tubes onto the two outlets on the 
flow head. 
 
2 Firmly push the other ends of the two air flow tubes onto the 
two outlets on the SP-304 spirometer unit. 
 
3 Plug the DIN connector of the spirometer into Channel 4 
(Figure 1). 
 
Start the Software 
1 Click on the Settings menu and select the Breathing-Rest-
Exercise settings file. 
 
2 After a short time, LabScribe will appear on the computer 
screen as configured by the Breathing-Rest-Exercise 
settings. 
 
3 Close the pdf file that opens automatically. 

 
Before Starting 
1 The spirometer will monitor breathing from a volunteer. It is 
important that the volunteer is healthy and has no history of 
respiratory or cardiovascular problems. 
 
2 The outlets on the flow head should always be in the upright 
position to avoid problems with condensation developing in the 
airflow tubes. 
 
3 Turbulence in the flow head will produce a noisy signal. To 
reduce turbulence, the subject should place his or her lips 
around the outside of the opening of the flowhead, or its 
mouthpiece, or its bacterial filter. 
 
4 Use a clip to prevent air from entering or leaving the nose as 
the subject is breathing. Air that passes through the nose is not 
included in the volume measurements and causes errors in 
these values. 
 
5 The settings file, Breathing-Rest-Exercise, programmed 
LabScribe to display the Airflow of the spirometer on Channel 
4, and the Volume on Channel 5. The settings file activates an 
algorithm designed specifically to convert the airflow data of 
the iWorx SP-304 spirometer to volume data. 
 
6 Right-click on the Volume Channel (CH 5). Select 
Spirometry and be sure that the Volume option is checked. If 
it is not checked, select it now. 
 
7 Allow the SP-304 to warm up for 10 minutes before recording 
for the first time. Do not hold the spirometer amplifier in your 
hand; the heat of your hand will alter the volumes recorded. 
 
8 Determine which opening of the flowhead should be used to 
make the deflection on the Airflow channel (CH 4) go up as 
the subject inhales. (See directions in next step.) 
 
9 Open the Window menu in the LabScribe software, and 
select Preview. A window displaying the signal coming into 
Channel 1 of the iWorx unit appears. Click on the arrows 
above the display to change the channel being viewed in the 
display to the Airflow channel. Watch the display as the 
subject inhales. To increase the size of the trace, click 
AutoScale. The trace on the display should go up as the 
subject inhales. If the trace goes down during inhalation, 
breathe through the other end of the flowhead or reverse the 
airflow tubes on the outlets of the flowhead. 
 
Exercise 1A: Breathing in Resting Volunteers 
Aim: To measure breathing parameters in a resting individual. 
 
Procedure 
1 The subject should sit quietly and become accustomed to 
breathing through the spirometer. They should be breathing 
normally before any recordings are made. Remember to hold 
the flowhead so that the outlets are on top. 
 
2 Have the subject remove the flowhead from his/her mouth. 
They should hold it at the same level as their mouth, but in a 
position that prevents his/her breath or any other airflow from 
moving through the flowhead. 
 
Note: The LabScribe software will zero the Volume channel 
during the first five seconds of recording. No air should be 
moving through the flow head during this time. 
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3 Click Start. Type “Resting” in the comment line to the right of 
the Mark button. After waiting five seconds for the Volume 
channel to zero, have the subject place the flowhead in their 
mouth and begin breathing. Press the Enter key on the 
keyboard. Click the AutoScale buttons for the Air Flow (CH 4) 
and Volume (CH 5) channels. Notice the slowly moving wave 
on the Volume channel. Record 5 breaths, which normally  
takes about 30 seconds. During this time, the Volume channel 
may automatically reset itself to zero; which it will do every 30 
seconds after the recording begins. 
 
4 Type “Maximum” on the comment line. Press the Enter key 
on the keyboard as the subject inhales as much as possible. 
As quickly as possible after reaching their maximum inhalation 
volume, the subject should exhale as quickly and as 
completely as possible. 
 
5 The volunteer should return to normal breathing through the 
spirometer. 
 
6 Click Stop to halt recording.   
 
7 Select Save As in the File menu, type a name for the file. 
Choose a destination on the computer in which to save the  
file(e.g. the iWorx or class folder). Click the Save button to 
save the file (as an *.iwd file). 
 
8 Now measure breathing parameters in all the other students 
in the lab group.Use a clean flowhead (or a new bacterial filter 
on the flowhead) for each new subject. Wash the flowhead in 
5% bleach solution and rinse it 5 or 6 times with deionized 
water. Dry it with a blow dryer. Be careful not to touch the 
membrane inside of the flow head. 
 
9 Open a new file for each new subject and repeat Exercise 
#1. Label each segment of file with appropriate comments. 
 
10 Once the relevant parameters are calculated for each 
student (see below), fill in the class data table provided in the 
lab. 
 
 
Data Analysis-Normal Breathing 
1 Scroll the data until the beginning of the first breathing cycle 
appears on the Main window. Adjust the Display Time (Figure 
2) so that two complete breathing cycles appear on the 
window. 
 
2 Click the 2-Cursor icon (Figure 2), so that two blue vertical 
lines appear over the recording window. 
 
3 Drag the blue cursor lines left and right so that the two 
complete breathing cycles are located between the two blue 
lines. 
 
4 Click the Analysis icon (Figure 2) to open the window. 
 

  
Figure 2: The LabScribe toolbar. 
 
5 Display only the Volume (CH 5) by clicking and deselecting 
all the other channels in the Display Channel list, on the left 
side of the Analysis window. Select Title, V2-V1, T2-T1, 
max_dv/dt, and min_dv/dt from the Table Functions list. 
 

6 Use the mouse to click and drag the cursors over each of the 
five breathing cycles to measure the following parameters: 
 
• Tidal Volume (TV): the amplitude of the breathing cycle. 
Place the one cursor in the trough prior to the inhalation, and 
the second cursor to the peak of the cycle. The value, V2-V1, 
is the Tidal Volume (Figure 3). 
  

 
 
Figure 3: The Volume displayed in the Analysis window; an upward 
deflection represents inspiration. The cursors are positioned on the trough 
and the peak of the signal to measure the tidal volume(V2-V1). 
 
• Period: the duration of each breathing cycle. The duration is 
easiest to measure between peaks or troughs on the Volume 
record. The value, T2-T1 is the Period (Figure 4). 
 

 
 
Figure 4: The Volume displayed in the Analysis window; an upward 
deflection represents inspiration. The cursors are positioned on the peaks of 
successive signals to measure the time interval (T2-T1). 
 
• Maximum Inspiratory Flow: the maximum rate of air 
movement during inhalation. Place the cursors on either side of 
the steepest portion of the volume curve recorded during 
inhalation. The value, max dv/dt, is the Maximum Inspiratory 
Flow rate (Figure 5).  
 

 
 
Figure 5; The Volume displayed in the Analysis window. The cursors are 
positioned on the steepest part of the inhalation slope. 
 
• Maximum Expiratory Flow: the maximum rate of air 
movement during exhalation. Place the cursors on either side 
of the steepest portion of the volume curve recorded during 
exhalation. The value, min dv/dt, is the Maximum Expiratory 
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Flow rate. Min dv/dt is used since the exhalation curve has a 
downward or negative slope. 
 
7 These data, along with the rest of the data for this lab, can be 
noted on the table on the last page of your handout. 
 
Data Analysis-Maximum Breathing 
1 Scroll the data in the Analysis window until the “Maximum” 
breathing cycle appears in the window. Adjust the Display 
Time (Figure 2) so the complete cycle appears on the window, 
from the normal tidal volume (or baseline) before the maximum 
inhalation to the flat line after the subject has completely 
expelled all the air from their lungs. Your data may look 
something like Figure 6. 
 
2 Click the 2-Cursor icon (Figure 2), so that two blue vertical 
lines appear over the Analysis window. Select Title, V2-
V1,T2-T1, max_dv/dt, and min_dv/dt from the Table 
Functions list. 
 
3 Drag the blue cursor lines left and right to measure; Tidal 
Volume (TV), Inspiratory Reserve (IR), Expiratory Reserve 
(ER), and the Vital Capacity (VC) (Figure 6).  Also, measure 
maximum rates for inspiratory and expiratory flows. 
 
 

 
 
Figure 6: Volume displayed in the Analysis window; an upward deflection 
represents inspiration. The trace shows a normal breathing cycle (left) and 
then a forced inspiration and expiration (right); labels show tidal volume 
(TV), inspiratory reserve volume (IR), expiratory reserve volume (ER), vital 
capacity (VC), and Forced Expiratory Volume at 1 Second (FEV(1)). 
 
4 Place a cursor on the point in the maximum volume trace 
where the maximum inspiratory volume is reached. Use the 
T2-T1 function to place the second cursor at a point that is one 
second after the position of the first cursor. The V2-V1 value 
for these two cursors equals the Forced Expiratory Volume at 1 
Second or FEV(1). 
 
Calculations 
1 Use the mean duration of the breathing cycles to measure 
breathing rate: 
Breathing Rate (Breaths/minute) = 60 seconds/minute 
mean duration (secs)/breath 
 

2 Multiply the mean tidal volume by the breathing rate to 
calculate the volume of air passing in and out of the resting 
subject’s lungs each minute. 
 
3 Determine the ratio of FEV(1) to VC. Normally, FEV(1) is 
compared to the Forced Ventilatory Capacity (FVC) which 
equals the Predicted Vital Capacity; but, for our purposes, 
we will use the actual Vital Capacity (VC). FEV(1)/FVC is an 
indicator of the severity of pulmonary impairment due to 
obstructions; any value greater than 65% is considered 
normal. 
 
Questions 
1 Are the lung volumes the same in all students? 
 
2 Combine class data to see whether there is any correlation 
between tidal volume or vital capacity and gender, smoking or 
apparent fitness? 
 
1B: Breathing Immediately After Exercise 
Aim: To measure breathing parameters after exercise. 
 
Procedure 
1 For this exercise, use just one subject.  Attach a clean 
flowhead to the spirometer. 
 
2 The volunteer should exercise to sufficiently elevate  
breathing rate, but with minimal class disruption. Running 
up and down flights of stairs is a good method. 
 
3 The volunteer should immediately sit down after concluding 
exercise. Click Start. Type “After Exercise” on the comment 
line to the right of the Mark button. 
 
4 After waiting five seconds for the Volume channel to zero, 
have the subject place the flowhead in their mouth and begin 
breathing. Press the Enter key on the keyboard. Record five 
complete breathing cycles. Click the AutoScale buttons for the 
Air Flow (CH 4) and Volume (CH 5) channels. 
 
5 Type “Maximum” on the comment line. Press the Enter key 
on the keyboard as the subject inhales as much as possible. 
As quickly as possible after reaching their maximum inhalation 
volume, the subject should exhale as quickly and as 
completely as possible. 
 
6 Click Stop to halt recording. 
 
7 Select Save As in the File menu, type a name for the file. 
Choose a destination on the computer in which to save the 
file(e.g. the iWorx or class folder). Click the Save button to 
save the file (as an *.iwd file). 
 
Data Analysis 
Measure the subject’s breathing parameters immediately after 
exercise using the same techniques used in Exercises 1 and 2.   
Add this data to the table in the back of your handout. 
 
 
Questions 
1 Did tidal volume change after exercise? Did inspiratory and 
expiratory reserves change after exercise? 
 
2 Did exercise influence the time taken for each breathing 
cycle? 
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3 Did the rate of air flow during the inhalation phase increase 
with exercise? How can you account for this? 
 
4 Did the rate of air flow during the exhalation phase increase 
with exercise—how can you account for this? 
 
5 Did the volume of air passing in and out of the resting 
volunteer’s lungs each minute increase due to exercise? If 
so, was this due to an increase in the rate of breathing, the 
depth of breathing (tidal volume) or a combination of both 
factors? 
 
6 Did exercise influence the vital capacity of the individual? 
 
7 If the tidal volume changed due to exercise, can this be 
accounted for by changes in the TV, IR, the ER or some 
combination of both? 
 
 
EXERCISE 2: FACTORS THAT AFFECT 
BREATHING PATTERNS 
 
Background 
The respiratory control center in the medulla is responsible for 
matching the amount of O2 used by and CO2 produced at the 
tissues, with the amount of O2 taken up and CO2 discharged at 
the lungs. Lung ventilation (L/min.) can be influenced by many 
factors, including emotion, speech, disease and the body’s 
position relative to gravity 
 
 
Before Starting 
1 The settings file, Breathing-Other Factors, programmed 
LabScribe to display the Pulse on channel 3, the Airflow of 
the spirometer on Channel 4, and the Volume on Channel 5. 
The settings file activates an algorithm designed specifically to 
convert the airflow data of the iWorx SP-304 spirometer to 
volume data. 
 
2 Right-click on the Volume Channel (CH 5). Select 
Spirometry and be sure that the Volume option is checked. If 
it is not checked, select it now. 
 
2A: Coughing 
Aim: To study any changes in breathing patterns due to 
coughing. 
 
Procedure 
1 The subject should sit quietly and become accustomed to 
breathing through the spirometer. They should be breathing 
normally before any recordings are made. Remember to hold 
the flowhead so that the outlets are on top. 
 
2 Have the subject remove the flowhead from their mouth. 
They should hold it at the same level as their mouth, but in a 
position that prevents their breath or any other airflow from 
moving through the flowhead. 
 
Note: The LabScribe software will zero the Volume channel 
during the first five seconds of recording. No air should be 
moving through the flow head during this time. 
 
3 Click Start. Type “Resting” in the comment line to the right of 
the Mark button. After waiting five seconds for the 
Volume channel to zero, have the subject place the 
flowhead in their mouth and begin breathing. Press the 

Enter key on the keyboard. Click the AutoScale buttons for 
the Air Flow (CH 4) and Volume (CH 5) channels. Notice the 
slowly moving wave on the Volume channel. Record 5 
breaths, which normally takes about 30 seconds. During this 
time, the Volume channel may automatically reset itself to 
zero; which it will do every 30 seconds after the recording 
begins. 
 
4 Type “Cough” on the comment line. Press the Enter key on 
the keyboard as the subject coughs. 
 
5 The volunteer should return to normal breathing through the 
spirometer. 
 
6 Click Stop to halt recording. 
 
7 Select Save As in the File menu, type a name for the file. 
Choose a destination on the computer in which to save the 
file(e.g. the iWorx or class folder). Click the Save button to 
save the file (as an *.iwd file). 
 
Data Analysis - Measurements 
1 Scroll the data until the beginning of the first breathing cycle 
appears on the Main window. Adjust the Display Time (Figure 
7) so that two complete breathing cycles appear on the 
window.  
 
 

 
 
Figure 7: The LabScribe toolbar. 
 
2 Click the 2-Cursor icon (Figure 7-15 on page 161), so that 
two blue vertical lines appear over the recording window. 
 
3 Drag the blue cursor lines left and right so that the two 
complete breathing cycles are located between the two blue 
lines. 
 
4 Click the Analysis icon (Figure 7) to open the Analysis 
window. 
 
5 Display only the Volume (CH 5) by clicking and deselecting 
all the other channels in Display Channel list, on the left side 
of the Analysis window. Select Title, V2-V1, max_dv/dt, and 
min_dv/dt from the Table Functions list. 
 

  
 
Figure 8: The Volume displayed in the Analysis window; an upward 
deflection represents inspiration. The cursors are positioned on the trough 
and the peak of the signal to measure the tidal volume(V2-V1). 
 
6 Use the mouse to click and drag the cursors over each of the 
five breathing cycles to measure the following parameters: 
• Tidal Volume (TV): the amplitude of breathing cycle. Place 
the one cursor in the trough prior to the inhalation, and the 
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second cursor to the peak of the cycle. The value, V2-V1, is 
the Tidal Volume (Figure 7-16 on page 161). 
 
• Maximum Inspiratory Flow: the maximum rate of air 
movement during inhalation. Place the cursors on either side of 
the steepest portion of the volume curve recorded during 
inhalation. The value, max dv/dt, is the Maximum Inspiratory 
Flow rate (Figure 9).  
 

 
 
Figure 9: The Volume displayed in the Analysis window. The cursors are 
positioned on the steepest part of the inhalation slope. 
 
• Maximum Expiratory Flow: the maximum rate of air 
movement during exhalation. Place the cursors on either side 
of the steepest portion of the volume curve recorded during 
exhalation. The value, min dv/dt, is the Maximum Expiratory 
Flow rate. Min dv/dt is used since the exhalation curve has a 
downward or negative slope. 
 
7 These data can be entered into the Journal by either typing 
the titles and values directly or by using the right-click menu. 
Place the cursors to take measurements; then, select Add 
Title to Journal or Add Data to Journal from the right-click 
menu to add the measurements to the Journal. 
 
8 Average the five values obtained for each parameter and 
enter them in a table in the Journal. 
 
9 Determine the maximum airflow during the cough. 
 
Questions 
1 What phase of the breathing cycle (exhalation or inhalation) 
immediately precedes the cough? 
 
2 Does the tidal volume change during the cough? 
 
3 If so, look at your data and determine if the tidal volume 
changed by changing the amount of air inhaled, exhaled or 
some combination of both? 
 
4 Compare the speed of air flow during a normal exhalation 
and the cough. Which is faster? 
 
2B: Concentration 
Aim: To study any changes in breathing patterns due to 
concentration. 
 
Procedure 
1 Push the tip of a needle firmly into a piece of wax or an 
eraser. Place the needle close to the subject, on the bench top 
or the top of the computer monitor. 
 
2 As before, the volunteer should not be disturbed and should 
be relaxed and accustomed to breathing through the 
spirometer. 
 

3 Have the subject remove the flowhead from their mouth. 
They should hold it at the same level as their mouth, but in a 
position that prevents their breath or any other airflow from 
moving through the flowhead. 
 
Note: The LabScribe software will zero the Volume channel 
during the first five seconds of recording. No air should be 
moving through the flow head during this time. 
 
4 Click Start. Type “Resting” in the comment line to the right of 
the Mark button. After waiting five seconds for the 
Volume channel to zero, have the subject place the 
flowhead in their mouth and begin breathing. Press the 
Enter key on the keyboard. Click the AutoScale buttons for 
the Air Flow (CH 4) and Volume (CH 5) channels. During this 
time, the Volume channel may automatically reset itself to 
zero; which it will do every 30 seconds after the recording 
begins. 
 
5 Type “Concentration” on the comment line. After the five 
normal breathing cycles, ask the volunteer to try to thread the 
needle. Press the Enter key on the keyboard as the subject 
begins their attempt. 
 
6 Type “Through” and press the Enter key on the keyboard 
when the needle has been threaded 
 
7 Click Stop to halt recording. 
 
8 Select Save in the File menu. 
 
 
Data Analysis 
1 Just as it was done in Exercise 1, determine the average 
Tidal Volume, Maximum Inspiratory Flow, and Maximum 
Expiratory Flow from the Volume channel (CH 5) before, 
during and after the threading the needle. 
 
2 Also, use the T2-T1 function from the list in the Analysis 
window to measure the Breath Duration for 5 adjacent cycles 
in each of the three experimental conditions (Figure 
10). 
 
3 Enter your data into the Journal and construct a table that 
enables a comparison of the four breathing parameters during 
each of the three conditions of the exercise.  
 

 
 
Figure 10: The Volume displayed in the Analysis window; an upward 
deflection represents inspiration. The cursors are positioned on the peaks of 
successive signals to measure the time interval (T2-T1). 

 
Questions 
1 Which breathing parameters change during the time when 
fine motor control is required? 
 
2 Can you explain your observations? 
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2B: Breathing after Hyperventilation 
Aim: To compare breathing before and after hyperventilation. 
 
Procedure 
1 In the same manner used above, make a continuous 
recording of breathing that will include 1 minute of normal 
breathing, one minute of hyperventiliation (breathing deeply 
and at the normal respiration rate) and one minute of normal 
breathing after the hyperventilation.   
 
2 Determine the breathing rate, the tidal volume, and the 
ventilation rate both before and after the hyperventilation.  Is 
there a hypoventilation to compensate for the prior  
hyperventilation, to allow blood gas levels to return to normal? 
 
 
2C: Breathing after Re-Breathing in a bag 
Aim: To compare breathing before and after re-breathing, 
when carbon dioxide levels are increasing and oxygen 
concentrations are decreasing in the bag, and in the body. 
 
Procedure 
1 Using the same methods as above, make a continuous 
recording of normal breathing for two minutes while breathing 
in/out of the bag.  Make sure that the bag is held tightly over 
the nose and mouth. 
 
2 Calculate and compare the respiratory rates, tidal volumes, 
and ventilation rates during the first and last 15 seconds of the 
period. 
 
EXERCISE 3: BREATH-HOLDING 
COMPARISONS 
Aim: To determine how prior breathing patterns, which will alter 
the normal blood oxygen and carbon dioxide concentrations, 
may affect the ability to hold one’s breath. 
 
Equipment Setup 
All you need is a paper/plastic bag, and a visible clock with a 
second hand. 
 
Procedure 
1 Each student should take a single deep breath and hold it as 
long as possible, timing this breath-holding period.  
 
2 After recovery from this, repeat the process, but first breathe 
the same air in/out of the bag for two minutes.  Take the deep 
breath just prior to breath-holding from the bag too.  Make sure 
to hold the bag over the nose and mouth, so that no new air is 
introduced. 
 
3 Finally, after breathing has returned to normal, the subject 
will take ten deep breaths at about the normal respiration rate 
and hold the 10th inhalation as long as possible.   
 
4 For all three of these breath-holding episodes, take care to 
inhale the same amount each time.  
 
5 Record and compare the breath-holding ability within an 
individual. 
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 Lab Partner Name After 
Exercise 

Coughing Concentration After 
Hyper-
ventilating 

After 
Rebreathing      

Normal          
TV (V2-V1)          
Period (V2-V1) 
 

         

Breathing Rate 
(Breaths/ min) 

         

Ventilation Rate 
(vol/min) 

         

Max Insp. Flow 
(max dv/dt) 

         

Max Exp. Flow 
(min dv/dt) 

         

Max 
Breath 

         

IR          
ER          
VC          
FEV1          
Max Ins          
Max Exp          

Breath 
Holding 

         

Normal          
After 
Hyperventilation 

         

After  
Hypoventilation 

         

 


